Baylor University
Institute for Oral History

Style Guide:
A Quick Reference
for
Editing Oral Memoirs

© Baylor University Institute for Oral History
GENERAL GUIDELINES

Spelling

Use the spell-checking function in Microsoft Word. It is an important and useful first step in checking a transcript. However, there are many kinds of errors it does not catch, and there is no substitute for careful, thoughtful proofreading. Use the dictionary. Do not be afraid to admit you don’t know a spelling, and do not assume you do know. Before you change how a word is spelled, look it up to make sure you are right.

Check the Word List

Interviewers sometimes make word lists—lists of words and names spoken in the course of their interviews which may not be familiar to everyone. When you begin working with a new recording, look in the interviewee’s Notes and Correspondence file for a word list and use it as you transcribe or edit. Add to it as you verify other words and names.

Common Pitfalls and Important Distinctions

all right (alright is not a word)

all together The children were all together again for Molly’s birthday.

altogether (adverb: wholly, entirely, completely) That is altogether unfair.

here I like it here.

hear I can’t hear what they said on the tape.

Dr Pepper Note there is no period in the name.

every day I eat lunch every day.

everyday (adjective: common) I think I’ll use my everyday dishes for the dinner party.

its (possessive) The cat was chasing its tail.

it’s (contraction of it is) It’s cold outside.

onto (preposition: to a place or position on; upon; on) Paste the label onto the top.

on to Let’s go on to Dallas since we’ve come this far already.

they’re (contraction of they are) They’re going to play rugby in the fall.

there (indicates location) Could you sit over there, please?

their (possessive) The children took off their coats.

to Are you going to school today?

too Did you graduate from Baylor, too? (Note the comma.)

Web site (Website is not a word, capitalized or not.)

whenever (conjunction: at whatever time; at any time when) Visit us whenever you like.
**whichever** (pronoun: any one that, no matter which; adjective: no matter which)  Do whichever is easiest. Whichever task you do, do it well.

**who’s** (contraction of **who is** or **who has**) Who’s that girl sitting over there?

**whose** (pronoun, possessive of who or which) Whose umbrella is that?

**yeah** Note this preferred spelling.

**Proofread**

Proofread your transcript. Look for words that the spell-checker may have missed: *form* instead of *from*, *Fort Worth* instead of *Fort Worth* (and do not use *Ft. Worth*, by the way), *though* instead of *thought*, *you* instead of *your*, *troll* instead of *Victrola*, *trolls* instead of *clothes* (all actual examples of spell-checker mistakes).

Check the format. Make sure that spacing and punctuation are correct. Make sure that apostrophes in front of dates go the right way (e.g. ’76) and that all quotations and parentheses are closed.

Check for consistency. If you make a decision on a matter of style in cases where the rules provide no clear guidance or allow for discretion, make sure you follow that decision throughout the transcript. If you verify and correct the spelling of a name, be sure to correct every occurrence.

**STYLE GUIDE**

**ABBREVIATIONS**

In general, avoid abbreviation in oral history transcripts. One general rule requires that a civil or military title appearing before a surname only should be spelled out, but it should be abbreviated before a given name and/or initial(s) plus surname.

   Governor Perry, but Gov. Rick Perry

Do not abbreviate:

- **okay**
- **et cetera**
- names of countries, territories, provinces, states, or counties
- **doctor** when used without an accompanying name
- **Senator, Judge, Bishop, General, Professor, Brother**, or any other political, academic, civic, judicial, religious, or military title when it is used alone or when it precedes a surname alone, i.e., Judge McCall
- **the Reverend** or **the Honorable**, when *the* is part of the title preceding the name
- books of the Bible
- names of the months and days
- terms of dimension, measurement, weight, degree, depth, et cetera: *inch, foot, mile*
- part of a book: 
  - Chapter 3
  - Section A
  - Table 7
• word elements of addresses used in text:
  
  - *Avenue, Building, North, South*
  - except *NW, NE, SE, and SW*

• portions of company names, unless the actual company name uses an abbreviation:
  
  - *Brother, Brothers, Company, Corporation, Incorporated, Limited, Railroad*

• *Senior or Junior* when following partial names:
  
  - Mr. Miller, Junior
  - Mr. Toland, Senior

Do abbreviate

• the following when they precede a given name and/or initial(s) plus surname:
  
  - Bro.  M.*  Mme*  Ms.  Sr.
  - Fr.  Mlle*  Mr.  Rt. Rev.  Sra.

  *Note the presence or absence of the period. For further guidance on French social titles, see *Chicago Manual of Style*, 15th edition, section 15.17, p. 562.

• Jr. or Sr. after given name and/or initial(s) plus surname:
  
  - John H. Smith Jr. (note that the comma is no longer required around Jr. and Sr.)

• *NE, NW, SE, SW* in addresses given in text

• points of the compass:
  
  - N, E, S, W, NE, SE, NNW, WSW, et cetera

• era designations:
  
  - AD 70, 753 BC

• time designations (see also “Small Caps” under “Capitalization” below):
  
  - AM, M, PM (note that when small caps are used, periods are omitted; if lowercase letters are used, the correct form is a.m., p.m. Whichever form is used, it must be used consistently throughout.)

• Initials only, initialisms, acronyms, reverse acronyms
  
  - Celebrated persons are often referred to by a full set of initials, often without periods, that represent the full name.
    - JFK, LBJ
  - Agencies and various types of organizations in government, industry, and education often are referred to by acronyms or initialisms:
    - AMA, IOOF, NATO, UN, USMC, USAF, USN, FDIC, SEC, AFL-CIO, or AF of L-CIO, SMU, Texas A&M

**ADDED MATERIAL—BRACKETS**

Brackets [ ] are reserved for the use of editors for notes and words not present on the recording and added to the transcript. The interviewee is free to add or delete material at his/her discretion on the first transcript. Such material is incorporated into the final text as indicated by the interviewee and does not appear in the first draft transcript unless indicated on a word list provided by the interviewer/first editor.

**ADDRESSES. See ABBREVIATIONS; NUMBERS**
BRACKETS. See ADDED MATERIAL; see also SOUNDS IN RECORDING OTHER THAN TALKING—PARENTHESES

CAPITALIZATION. See also NAMES

• The Institute for Oral History uses a “down” style of capitalization, as described in the Chicago Manual of Style, 15th edition, page 311, Section 8.2.
• As a rule of thumb, when in doubt, do not capitalize. When the Chicago Manual of Style or the dictionary allows for discretion or says that a class of words may be or usually is lowercased, the institute uses the lowercase form.
• Proper names of institutions, organizations, persons, places, and things follow the forms of standard English practice. When in doubt, consult the dictionary or the Chicago Manual of Style chapter on names and terms for specific cases and examples. If still in doubt, don’t capitalize. Partial names of institutions, organizations, or places are usually written in lower case.

Do capitalize:
• names of particular persons, places, organizations, historical time periods, historical events, biblical events and concepts, movements, calendar terms referring to specific days, months, and oriental years
• titles of creative works
• references to athletic, national, political, regional, religious, and social groups: Baylor Bears, Congress, Democrats, Daughters of the American Revolution, the Masons
• Capitalize Internet and Web always:

She suggested that he search the Internet for more information.
He found a Web site that answered many of his questions.
Note that website is not a word; use Web site.

Small caps

• If possible, format time designations as small caps: AM and PM. Type the letters in lower case, select the text, select Format on the menu bar at the top of the window, click Font, check “small cap.”
• Alternatively, select the lowercase letters and type Ctrl-Btn-K.
• Note that periods are not used with these abbreviations in the small caps format. If lowercase format is used, the correct forms are: a.m. and p.m.

Don’t capitalize:
• oh except at the beginning of a sentence or response
• incomplete titles of persons
• names of dances, but do capitalize names of dancing events: They danced the jitterbug all night long. He invited her to the Society Ball.
• pronouns referring to deities: God in his mercy kept my child safe.
### Capitalization Examples:

<table>
<thead>
<tr>
<th>Capitalize</th>
<th>Lowercase</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board of Trustees of Baylor University</td>
<td>board of trustees, the board, the trustees</td>
</tr>
<tr>
<td>the University of Virginia</td>
<td>the university</td>
</tr>
<tr>
<td>Department of History</td>
<td>the history department</td>
</tr>
<tr>
<td>School of Nursing</td>
<td>the nursing school</td>
</tr>
<tr>
<td>course titles: History 1301; History of Texas; Microeconomics</td>
<td>courses: economics, history, philosophy, but French, Spanish, English</td>
</tr>
<tr>
<td>McLennan County</td>
<td>We lived out in the county</td>
</tr>
<tr>
<td>City of Woodway; State of Texas; Commonwealth of Virginia (if referring to official entity)</td>
<td>We moved to the city of Dallas. the state bird of Texas</td>
</tr>
<tr>
<td>New York Times; the Times</td>
<td>the newspaper</td>
</tr>
<tr>
<td>regional designations: the West, the Southwest</td>
<td>directional terms: to travel west, to face southwest</td>
</tr>
<tr>
<td>Central Texas</td>
<td>the central region of Texas</td>
</tr>
<tr>
<td>an Easterner, Western American history</td>
<td>a western university</td>
</tr>
<tr>
<td>West Coast, Gulf Coast</td>
<td>the coast</td>
</tr>
<tr>
<td>Interstate 35, IH35 or I-35</td>
<td>the interstate, the highway</td>
</tr>
<tr>
<td>Eighth Street</td>
<td>the street</td>
</tr>
<tr>
<td>Bible</td>
<td>biblical work</td>
</tr>
<tr>
<td>Scripture(s)</td>
<td>scriptural passage</td>
</tr>
<tr>
<td>Veterans Administration</td>
<td>the university administration</td>
</tr>
<tr>
<td>Veterans Administration Hospital</td>
<td>a veterans hospital</td>
</tr>
<tr>
<td>the Institute for Oral History</td>
<td>the institute</td>
</tr>
<tr>
<td>the Texas Collection</td>
<td>the collection</td>
</tr>
<tr>
<td>the Word of God</td>
<td>the words of the song</td>
</tr>
<tr>
<td>the Fall (of Man)</td>
<td>the fall of 1992</td>
</tr>
<tr>
<td>the Gospel of Luke (Matthew, et cetera)</td>
<td>the gospel</td>
</tr>
<tr>
<td>the Book of Daniel</td>
<td>a book of poetry</td>
</tr>
<tr>
<td>McLennan County Court</td>
<td>county court</td>
</tr>
<tr>
<td>Washington Street Bridge</td>
<td>the bridge</td>
</tr>
<tr>
<td>American Revolution</td>
<td>the revolution of the colonies</td>
</tr>
<tr>
<td>World War I, First World War</td>
<td>the war</td>
</tr>
<tr>
<td>General of the Army Douglas MacArthur</td>
<td>MacArthur, a general, U.S. Army</td>
</tr>
<tr>
<td>President Harry Truman</td>
<td>the president of the USA, presidency</td>
</tr>
<tr>
<td>the Bronze Age</td>
<td>the third of the four ages of man</td>
</tr>
</tbody>
</table>
**Capitalize**

- the Democratic Party
- the Democrats (party members)
- Great Depression (referring to 1930s), the Depression
- Sherman Antitrust Act
- Bro. Adam Smith, Brother Smith, Aunt Kathryn
- Grandmother, Grandpa Smith, Dad (substitute for given name)
- U.S. Senate
- Capitol (referring to building)

**Lowercase**

- the party that won in that precinct; a democratic form of government
- democracy
- a recession; the distinction between a recession and a depression
- an act of Congress
- my brother, Bob; Kathryn, my aunt
- my grandmother, Elizabeth; my mother
- the capital of Texas (referring to the city)

**COINED WORDS. See SPELLING PROBLEMS**

**COLLOQUIALISMS. See SPELLING PROBLEMS**

**COMMAS**

- No, sir.
- Yes, sir.
- Oh, yes.
- Oh, no.
- Thanks, Mrs. Pool.
- Yeah, that’s right. *(Note correct spelling of yeah.)*
- Well, I’m from California originally.
- I was born in Dallas, Texas, in 1904.
- I mean, what are you going to do about it?
- So we, you know, went back home.
- And, of course, we were pretty angry.
- She was, like, my best friend.

**COMPOUND WORDS. See HYPHENS**

**CRUTCH WORDS. See also FALSE STARTS; FEEDBACK WORDS AND SOUNDS**

Spell common crutch words as follows:

- uh
- uh-huh
- um-hm
- unh-uh

**DASHES**

The em dash (—) is used in BUIOH memoirs without preceding or following spaces or punctuation to indicate:

- a hanging phrase resulting in an incomplete sentence (do not use ellipses)
- a parenthetic expression or statement
- an interruption by another speaker
• resumption of a statement after an interruption
• a meaningful pause on the part of the speaker

DATES.  See also NUMBERS

In the heading on the first page of a transcript, type the date in month, day, year form:
January 1, 2003

Elsewhere in the transcript, typing dates conforms to the rules for typing numbers:
• Use numerals for years (1996) except when a sentence begins with a year:
  Nineteen sixty-two was an important year for me.
• Use numerals for days when they follow the name of the month and precede the year;
  follow this form even when the speaker says, “August the fifth, nineteen eighty-seven.”
  Today is August 5, 1987.
• Spell out the words for the day when the year is not expressed and the speaker uses the
  ordinal number:
  My birthday is August fifth.
  My birthday is August the fifth.
• Spell out the word for the day when the day precedes the month:
  the fifth of August
• Other examples:
  1930s; the thirties; 1989 or ’90; midsixties; mid-1960s.
• When spelling out 1906, use Nineteen 0-six or Nineteen aught-six.

DIALECT.  See SPELLING PROBLEMS

DIRECT ADDRESS

Set off by commas:
  Pam, I know you will enjoy this.

DIVISION OF WORDS AND NUMBERS.  See also HYPHENS

• Do not hyphenate at the ends of lines in transcripts.  If the automatic hyphenation function
  has been enabled in the word processing software, disable it.  This eliminates most issues
  concerning the correct hyphenation of words for the institute’s transcripts.  If questions do
  arise, consult the Chicago Manual of Style.
• Do take care that automatic wrapping of text lines does not separate initials from a
  surname, parts of an acronym or abbreviation, or divisional marks such as a), (1), (i), from
  material to which they pertain.  If necessary to keep these elements together, replace a
  normal space with a nonbreaking space (Insert→Symbol→Special character in the
  Microsoft Word menu).

EDITORIAL NOTES.  See ADDED MATERIAL

ELLIPSES

Do not use ellipses ( . . ) in transcribing oral history recordings because they would give the
appearance that material was left out.
FALSE STARTS

A false start may be anything from a syllable to a sentence. Repeated words, phrases, or syllables are at times indicative of a person’s thought patterns, overall speech patterns, personality patterns, or of a speaker’s effort to emphasize an element of communication. Sometimes an interviewee may be deliberately ambiguous or turgid for reasons of his or her own. Where to draw the line in deleting false-start material from the transcript is a difficult decision. We strive to follow a middle course, leaving in enough to indicate individual speech patterns. If repetition is for emphasis as reflected in the voice of the interviewee, the repetition is always retained. Do not try to indicate stuttering unless it is intentional.

FEEDBACK WORDS AND SOUNDS (crutch words, encouraging words, and guggles)

While there is some merit in having an absolutely verbatim transcript which includes all instances of feedback (such as um-hm and yeah), too many interruptions in the flow of a speaker’s remarks make for tedious transcribing now and exhausting reading later. Knowing when to include feedback sounds and when to omit them calls for very careful judgment. Usually the interviewer’s noises are intended to encourage the interviewee to keep talking. If every other line or so of the transcript consists of feedback, go back and carefully evaluate the merit of each instance. Do not include it all, especially if it interrupts the interviewee’s comments in midstream. Only if the feedback is a definite response to a point being made by the interviewee should you include it. When in doubt, ask.

Type no more than two crutch words per occurrence. Crutch words are words, syllables, or phrases of interjection designating hesitation and characteristically used instead of pauses to allow thinking time for the speaker. They also may be used to elicit supportive feedback or simple response from the listener, such as: you know, see? or understand?

- Use of *Uh*: The most common word used as a crutch word is *uh*.
- When *uh* is used by the narrator as a stalling device or a significant pause, then type *uh*. But sometimes a person will repeatedly enunciate words ending with a hard consonant with an added “uh,” as in *and-uh, at-uh, did-uh, that-uh, in-uh*. Other examples are *to-uh, of-uh, they-uh*. In these instances, do not type *uh*.

Guggles are words or syllables used to interrupt, foreshorten, or end responses, and also as sounds of encouragement. Guggles are short sounds, often staccato, uttered by the interviewer to signal his desire to communicate. They may be initial syllables of words or merely *oh, uh, ah*, or *er*. Spelling of specific guggles:

- Agreement or affirmation: uh-huh, um-hm
- Disagreement: unh-uh

FRACTIONS. See NUMBERS

GRADES, SCHOLASTIC

Type letter grade in capital letter with no period following, no italics, and no quotation marks. Show number grade in Arabic numerals with no quotation marks and no following period. Plural should be formed only by adding *s*, except where confusion with another word is possible.

I made all A’s by earning 100s on all my exams, but my roommate made only Bs.
GUGGLES. *See* FEEDBACK WORDS

HYPHENS. *See also* DIVISION OF WORDS AND NUMBERS

For guidance on use of hyphens to form compound words and phrases, please refer first to section 7.90 in *The Chicago Manual of Style*, 15th edition, and then to the unabridged dictionary. Many words that were once hyphenated are no longer, so *The Chicago Manual of Style* should be relied upon as the most up-to-date authority.

vice-president is now vice president
post-doctoral is now postdoctoral

But when the second element is capitalized, retain the hyphen:
post-World War II
post-Civil War

Hyphenate

- to indicate division or separation in the following:
  - division of words into syllables, as in syl-la-ble
  - spelling out a name or words, as in H-o-r-a-c-e. Capitalize only where appropriate.
  - separation of numerator from denominator in a fraction expressed in words unless the numerator or the denominator is hyphenated. In that case, use / to separate numerator from denominator.
    one-fifth
    three/thirty-seconds

- to indicate unification or combination as follows:
  - nouns made up of two or more nouns which imply the combination or unification of two or more linked things, functions, or characteristics, as in AFL-CIO, astronaut-scientist
  - modifiers and adjectival compounds when used before the noun being modified, not after, including those formed with numbers:
    a one-of-a-kind student

- to indicate an infrequent pronunciation or meaning of a word:
  re-creation, recreation
  re-cover, recover
  re-form, reform

- to indicate clear meaning when possible confusion could result from adding a prefix to a word starting with a vowel, as in co-op—usually, this convention operates with doubled vowels.

Do not hyphenate

- a noun compound of a spelled-out number and prefix, as in mideighties (but do hyphenate prefix plus numerals, as in mid-1980s).
- chemical terms, as in sodium nitrate, sodium silicate, bismuth oxychloride
- a compound modifier that follows the noun it modifies unless hyphenated in dictionary:
  Her argument was well balanced.
  She was good-natured.
• a compound modifier that includes an adverb ending in –ly:
  wholly fictitious
• a hyphenated word at the end of a line other than at the hyphen
• a proper noun except when absolutely unavoidable
• contractions, such as: can’t, wouldn’t, don’t, didn’t, wasn’t, he’ll, they’re, she’d

INCOMPLETE SENTENCES

Incomplete sentences are familiar occurrences in oral history because of its conversational nature. They are best ended with an em dash (—).

INFORMAL LANGUAGE. See SPELLING PROBLEMS

ITALICS. See QUOTATION MARKS for titles not in italics.

Italicize:
• titles of whole published works, such as Plain Speaking
• titles of books, bulletins, periodicals, pamphlets
• titles of long poems
• titles of plays and motion pictures
• titles of long musical compositions: operas, operettas, musical comedies, oratorios, ballets, tone poems, concertos, sonatas, concerti grossi, symphonies, and suites, but not descriptive titles or attributed titles
• Titles—actual titles, rather than descriptive or attributed titles—of paintings, sculptures, drawings, mobiles:
  You may know that da Vinci’s Mona Lisa is actually La Gioconda.
• names of spacecraft, aircraft, and ships, except for abbreviations preceding the names, such as designsations of class or manufacture, as follows:
  SS Olympic
  HMS Queen Elizabeth
  USS Lexington
  Friendship VII
• foreign words and phrases that are not in common currency; when in doubt, don’t italicize. Consult the dictionary; don’t italicize a quotation in a foreign language.
• a foreign word or phrase when followed by a translation; enclose translation in quotation marks and precede translation by a comma:
  J’ai mal à la tête, “I have a headache.”
• for emphasis (use sparingly)
• references to words as words, phrases as phrases, or letters as letters: Often is a word I seldom use.
• in indexes, the cross-reference terms, See and See also
• titles of legal cases, except in footnotes where only ex parte, ex rel., and in re are italicized along with other Latin words
• enumeration letters referring to subdivisions within a sentence or within a paragraph as well as those appearing in lists, when such letters are in lower case, such as a, b, or c
• newspaper names and the city names that accompany them: *New York Times*
  Note: Do not italicize any articles preceding a newspaper name. Example: the *Times*.

**LEGAL CASES**

Italicize titles of legal cases, with *v.* for versus:
*Brown v. Board of Education of Topeka, Kansas*
the *Miranda* case

**MONEY. See NUMBERS**

**NAMES. See also ABBREVIATIONS; CAPITALIZATION; ITALICS; QUOTATION MARKS**

The spelling of proper names of persons or locations is one of the transcriber’s most difficult tasks. The office has many reference works which contain names and places. Ask for help.

**NEOLOGISMS. See SPELLING PROBLEMS**

**NUMBERS**

In general, spell out whole numbers, whether cardinal or ordinal, from one to ninety-nine, and any of those numbers followed by hundred, thousand, hundred thousand, million, and so on, hyphenated or not.

  sixty-nine
  seventy-fifth
  twenty-two hundred, but 2,367. Note: When there are several numbers in a sentence or a group of numbers includes numbers over one hundred, you may use numerals for brevity and consistency.

  • Always spell out the number if it is the first word in a sentence.
    When were you born? Nineteen sixty-five.
    When were you born? In 1965.

  • Spell out the number if it is the name of a street and under one hundred.
    454 Fourth Street

  • Spell out decades such as fifties, sixties, but 1960s, 1970s.

  • Use numerals for percentages.
    Only 45 percent of board members approved of the measure.

See also the chapter on numbers in the *Chicago Manual of Style*.

Do not spell out:

  • street address numbers, intrabuilding numbers, highway numbers
    10 Downing Street
    304 Carroll Library
    IH35

  • telephone numbers

  • fractional sums of money above one dollar: $2.98

  • dates: *See also* DATES above
    735 BC  mid-1950s
    AD 1066  the midfifties
1990s  midfifties fashions
24 February 1997  July 1997  (no comma)

- time of day—use numerals when AM or PM follow or when typing a whole plus a fraction of an hour: (See “Small caps” under “Capitalization” above for proper formatting.)
  8:20 PM  four o’clock
  7:30  seven in the morning

- number elements in names of government bodies and subdivisions of 100th and higher, all union locals and lodges
  Thirty-sixth Infantry
  139th Tactical Wing

- parts of a book, such as chapter numbers, verse numbers
- percentages, as in 50 percent
- For consistency any sentence which contains numerals pertaining to the same category should have all numerals.
  The report stated that 7 [instead of seven] out of 265 students voted in the campus elections.

  Exceptions:
  - The sentence begins with a number:
    Seven out of 265 students voted.
  - Numbers representing different categories:
    In the past ten years five new buildings of over 125 stories have been erected in the city.

Numbers as numbers:
When spoken of or referred to as numbers, they may be enclosed in quotation marks or italicized; either is acceptable, but be consistent throughout the transcript.

Plurals of numbers:
- Spelled-out numbers form plurals like any other noun:
  the twenties and thirties
- Numerals form plurals by adding s alone, with no apostrophe:
  1920s and 1930s
- When connecting figures with a prefix or suffix, add the hyphen in the appropriate place if the compound word is adjectival. Connect numbers expressed in words to a prefix or suffix with a hyphen:
  twenty-odd
  The suffix fold is an exception
  threefold

PAGE NUMBERS

Lowercase Roman numerals are used on front matter preceding the main text. The title page is considered to be page i but is not marked.

For text, appendix, and index pages, page numbers (in Arabic figures) appear on the lower right of each page except the first. Number appendix and index in sequence with the text pages and place the appendix pages between the end of the text and the index.
PARAGRAPHS

Press the Enter key to start a new paragraph wherever topics change, where subtopics are introduced, or where other dialogue is introduced. This may be very difficult to judge as you are typing and is often left up to the final editor.

PARENTHESES. See SOUNDS IN RECORDING OTHER THAN TALKING—PARENTHESES

PLURALS. See also NUMBERS.

- Compound words formed with prepositions are pluralized by forming the plurals of the first nouns in the compounds:
  fathers-in-law

- Capital letters of the alphabet are pluralized by adding s or ‘s:
  Zs
  Use the apostrophe only where confusion is possible:
  A’s, not As
  Lowercase letters form the plural by adding ‘s:
  p’s and q’s

- Foreign words are made plural, unless Americanized, according to the customs proper to the particular languages. For example, in Hebrew, the plural of Kibbutz is formed by adding im:
  Kibbutzim.

- Abbreviations are pluralized by adding s when in the form of acronyms, initialisms, or reverse acronyms without periods
  GREs
  When periods are used, add an apostrophe:
  B. K.’s

- Proper nouns: Add s to the singular if the addition does not make an extra syllable:
  six King Georges
  Add es to the singular form if the addition creates an extra syllable:
  six King Charleses
  Nouns—including names of persons—that end in s take addition of es to form the plural:
  The three Loises are friends with the three Marys.
  The hall was full of Joneses and Martins.
  Note that the apostrophe is never used to denote the plural of a personal name.

POSSESSIVES

- Follow the standard rules for possessives.
- For proper nouns, add ‘s to most, even those ending in sibilant sounds:
  Charlie’s, Frances’s
  However:
  Jesus’ and Moses’
  For plural possessives, the apostrophe goes at the end:
  The Smiths’ fortune was lost in the Depression.
Collective nouns are exceptions:
children’s

PUNCTUATION. See also DASHES; HYPHENS; QUOTATION MARKS.

Transcript punctuation follows The Chicago Manual of Style, 15th ed.

QUOTATION MARKS

• When a direct expression is spoken by one person (I, he, she), set apart the expression with commas, use opening and closing quotation marks, and capitalize the first letter of the first word quoted.
  She said, “I am going to graduate in May.”
• When a direct expression is spoken by more than one person (we, they), do not use quotation marks, but do set apart the expression with commas and do capitalize the first letter of the first word quoted.
  They said, What are you doing here?
• When a thought is quoted, do not use quotation marks, but do set the thought apart by commas and capitalize the first letter of the first word quoted.
  I thought, Where am I?
• Enclose in quotation marks when text refers to
  o titles of articles in periodicals
  o book chapter titles
  o book divisions other than chapter titles: sections, paragraphs, charts, and other labeled book parts
  o dissertation titles
  o essay titles
  o newspaper headlines (in all capital letters)
  o poems (short, not book length)
  o radio program titles
  o sermon titles
  o short musical composition titles when not designated by number
  o song titles
  o short story titles
  o television program titles
  o theses (unpublished)
  o lecture titles
  o titles of formal courses of study
  o debate topics

Do not enclose in quotation marks
• names or words used in conjunction with the words call, called, named, or words with similar meanings.
  Call me Adam.
  We named the dog Bowser.
• the word yes or the word no other than in a sentence which includes other direct discourse.
  He couldn’t say no, yet he didn’t really want to say yes.
  She said, “No,” when asked, “Do you care to join us?”
• thoughts or paraphrases:
  I thought to myself, Who does she think she is?

Punctuation with quotation marks:
• The period and the comma always stay inside the quotation marks.
  “I’m ready for lunch,” she said, “but it’s only ten o’clock.”
• The semicolon and the colon always stay outside the quotations.
  With trepidation, she scanned “The Raven”; it was too eerie for her tastes.
• The em dash, exclamation mark, and question mark are within the quotation marks when
  they apply only to the quotation.
  She began to say, “In the spring of 1920—” and then remembered it was a year later.
  She began by saying, “In the spring of 1920,”—I think it was really 1921—“I graduated
  from Baylor and began teaching school.”

RECORDING TRANSITIONS

• recording breaks:
  Side 1 ends; side 2 begins.
  Tape 1, side 1 ends; side 2 begins.
  Tape 1 ends; tape 2 begins.
  Tape 2, side 1 ends; side 2 begins.
• a pause in recording, when recording is turned off and then on again, when sound fades out,
  et cetera:
  pause in recording
• the end of the interview:
  end of interview

REFERENCE WORKS

The office has a good supply of reference books on many subjects. It’s a good idea to ask what
sources are available before you begin a transcribing project. For stylistic purposes, consult the
dictionary and The Chicago Manual of Style; if the two conflict, try to follow Chicago.

RELIGIOUS NAMES AND TERMS

The institute prefers a “down” style of capitalization for religious names and terms.

For a complete guide to capitalization of religious terms, the names of deities and religious groups,
movements, organizations, and religious writings, see the Chicago Manual of Style, 15th edition, pages
347-353.

SLANG. See SPELLING PROBLEMS.

SOUNDS IN RECORDING OTHER THAN TALKING—PARENTHESES

Nonverbal sounds or events which occur in the recording are noted and enclosed in parentheses,
especially if they intrude significantly or affect the intelligibility of the recording and certainly if they
provokes a response from those present. For such notations, use no capital letters, unless for proper
nouns or proper adjectives, and no ending punctuation. When these occur at the end of a sentence
or a clause, position them after the punctuation. Reserve the use of parentheses for such activity notes.

- **Descriptive terms:**
  - (laughs) when speaker laughs
  - (Jeffrey laughs) when person other than speaker laughs
  - (laughter) or (both laugh) when more than one laughs.
  - (unintelligible)
  - (telephone rings)
  - (knock at the door)

- Avoid editorializing. Use (both talking at once) or (speaking at same time)—NOT (interrupts); use (laughs), not (laughs rudely).

**SPACING**

- two spaces after a period and after a colon
- one space between words and before and after parentheses in the middle of a sentence
- no space before or after em dashes (—)
- one space between initials in a name (e.g. J. F. Kennedy)
- When something has been italicized, it may look as though there is no space before or after the italicized text. To verify spaces, increase the font size and/or change Microsoft Word options so that formatting marks are visible (from the menu bar at the top of the document window, click on Tools → Options, select the View tab, and in the Formatting Marks section, make sure that the box next to Spaces is checked).

**SPELLED-OUT WORDS**

- When a speaker spells a word, capitalize appropriately and separate letters with hyphens:
  - B-a-y-l-o-r
- Follow the exact words of the speaker:
  - They called him Screech, spelled capital S-c-r-double e-c-h.

**SPELLING PROBLEMS. See also ABBREVIATIONS; CAPITALIZATION; DIVISION; HYPHENS; NUMBERS.**

- Always use the word processing software’s spell-check function before printing and always look up a word if you are not completely sure of its spelling. When the dictionary allows more than one spelling of a word, chose the first one listed.

<table>
<thead>
<tr>
<th>DO</th>
<th>DON'T</th>
</tr>
</thead>
<tbody>
<tr>
<td>for a while</td>
<td>for awhile</td>
</tr>
<tr>
<td>awhile ago</td>
<td>a while ago</td>
</tr>
<tr>
<td>all right</td>
<td>alright</td>
</tr>
<tr>
<td>until, till</td>
<td>‘til</td>
</tr>
<tr>
<td>nowadays</td>
<td>now-a-days</td>
</tr>
<tr>
<td>apiece</td>
<td>a piece</td>
</tr>
<tr>
<td>inasmuch as</td>
<td>in as much as</td>
</tr>
<tr>
<td>insofar as</td>
<td>in so far as</td>
</tr>
</tbody>
</table>
DO                 DON’T
Channel 10          Channel Ten
a lot               alot
et cetera           etc.
okay                O.K.

- Always check the interview files to locate a word list for each recording. Interviewers may make lists to accompany the recording; using the lists saves time and results in a more accurate transcript. Please include the word list with the transcript when passing it on to the audit checker or the final editor.

- Spellings for slang and certain words and expressions pronounced in regional dialect are available in dictionaries or reference works in the office. Words of informal language, such as *yeab* and *yep*, may be transcribed verbatim if they occur in the dictionary. Words commonly pronounced together in spoken English—such as *gonna* (going to), *sorta* (sort of), and *kinda* (kind of)—are in the unabridged dictionary and may be used in the first edited version of the transcript. The interviewee often edits them out.

- Interviewees occasionally coin words, either humorously or to convey a meaning for which they cannot find an existing word. If you cannot find a word in any dictionary but can hear it clearly and can devise a reasonable spelling for it, transcribe it and place it in quotation marks the first time it occurs. Do not use quotation marks for every occurrence of the coined word, however, as it makes for tedious reading.

**TAPE BREAKS. See RECORDING TRANSITIONS**

**TITLES. See ABBREVIATIONS; ITALICS; NAMES; QUOTATION MARKS**

**UH-HUH, UM-HM, UNH-UH. See FEEDBACK WORDS**

**UNINTELLIGIBLE SPOTS IN RECORDING**

- When speech on a recording is unintelligible, first play it at higher volume and/or slower speed. Next, ask someone else to listen. Don’t struggle alone. If the interviewer is one of the BUOH faculty, ask her or him for help.

- If you can make an educated guess, type the closest possible approximation of what you hear, underline the questionable portion, and add two question marks in parentheses.
  
  *I went to school in Maryville(??) or Maryfield(??).*

- If you and those you consult cannot make a guess as to what is said, leave a blank line and two question marks in parentheses.
  
  *We’d take our cotton to Mr. _________(??)’s gin in Cameron.*

- If a speaker lowers his or her voice, turns away from the microphone, or speaks over another person, it may be necessary to declare that portion of recording unintelligible.
  
  *When he’d say that, we’d—(laughs; unintelligible).*
WORD LISTS

Interviewers sometimes make word lists—lists of words and names spoken in the course of their interviews which may not be familiar to everyone. When you begin working with a new recording, look in the interviewee’s Notes and Correspondence file for a word list and use it as you transcribe or edit. Add to it as you verify other words and names.